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District Update: By Jeanne Farina 
 
The summer was both busy and productive for our HPS Technology staff.  When staff 
leaves for the summer it is time for the tech department staff to “kick it into gear” and get 
many projects completed that we are unable to do during the school year.  Here are some 
of the tasks completed by the tech department staff this summer.   
 

• New Internet Accounts – These new accounts replace the hps.k12.mi.us 
accounts for Internet mail accessed at school for all staff.  The new accounts are 
the last 7 characters of your last name plus your first initial, example: 
(farinaj@howellschools.com).  The account can be no larger than 8 characters.  
This is the account that will be used here at school for outside Internet mail.  The 
old dial up account is still active and you may use it to receive Internet mail at 
home, example: farinaj@hps.k12.mi.us   Please Note:  even though this account 
will remain active it will not be used here at school for Internet mail; therefore, 
you may want to simply switch to the howellschools.com account for all of your 
internet mail and let all of your contacts know that this is now your Internet email 
account. 

• Software upgrades - All networked computers were upgraded to Office 2000 and 
Windows 2000.   
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• Teacher Technology Initiative (TTI) - Many hours were spent organizing the 
procedures for this equipment to be ordered, inventoried and distributed to staff 
throughout the district.  Teachers have received Dell laptop and desktop 
computers, scanners, digital cameras and a variety of other peripheral equipment. 
You can check to see the status of your item/s by going to 
www.howellschools.com and clicking the TTI link at the top of the page.  

• Tomorrows Technology for Today’s Teachers (T4) - This 
curriculum/technology integration training was a huge success for the 40 plus 
teachers who participated during July.  We look forward to continuing this 
successful model during the 2001-02 school year. 

• Web Teleform - A new web teleform was developed allowing us to issue survey-
type forms that may be taken over the Internet.  This teleform proved useful for 
evaluations of our T4 program.  We will be using it for many other applications 
throughout the district. 

• Centralized Student Enrollment - We implemented our new centralized 
enrollment process.  Nearly 500 new students were enrolled and entered into 
SASI our student management system.  This process allowed us to continually 
monitor and make adjustments to accommodate hiring of new staff in personnel 
and new bus runs for transportation.  

• Student Network ID’s - Student ID’s and passwords have been issued for all 
8,000 plus students at Howell Public Schools.  Please remind your students that 
their accounts and passwords are private and should not be given out to anyone.  
These accounts will be used throughout a student’s K-12 career at HPS.  Once the 
student graduates the accounts will be removed.  This will allow our students to 
have private space on our network to save their work.  The accounts will also 
allow us to remove programs (like Internet access) from individual student login 
scripts, where access has been removed due to disciplinary measures or in cases 
where parents do not wish their children to access the Internet.  

 
• Internet Use Form for Students - A new form went out to all parents of students 

who attend Howell Public Schools.  This form states that the Internet will be used 
in our classrooms as an instructional tool.  If parents do not wish their 
son/daughter to use the Internet at school they must sign this form and return it to 
their building and the technology department.  The Internet icon will be removed 
from that student’s login script.  

• Wireless Laptop Lab - A new 32-laptop wireless cart will be added to the High 
School.  It is in the process of being set up now and moved to the High School.  
The cart can be moved into any classroom in the High School and allow classes to 
use the laptops instead of taking their class to the computer lab.  If you are 
interested in using the lab Elson Liu will work with you to demonstrate how it can 
be moved to your room. 

• Wireless Network connections between buildings - Wireless connections 
between McPherson Middle School, HWMS and the HS were installed.  This 
allowed our wide area network to remain functioning even when district 
construction projects cut fiber between these buildings. 

http://www.howellschools.com/


• Garage Sale - A district garage sale where surplus equipment was sold was held 
in August.  Many vintage Apple IIE computers and other old PC computers were 
sold to happy homes.  If you missed it…it will be back in a few years when 
surplus equipment is again an issue. 

• Media Centers - Four elementary media centers received five new PC computers 
each and new software upgrades, replacing old Apple computer servers and 
workstations within their media centers.  All media centers in the district were 
upgraded to the new Winnebago Spectrum Suite software. 

• Computer Replacement - Teacher computers and office computers at Voyager 
elementary were replaced.  Sixty computers were purchased replacing the 
computers from H-1 and H-2 Business labs at the High School.  Howell High 
School business labs will also receive additional workstation furniture to 
accommodate the increased number of computers and students that they serve. 

• New Phone System - A new phone system has been installed at Howell High, 
McPherson, Highlander Way and the Transportation buildings.  All buildings in 
the district will soon be converted to the new system that has been purchased with 
funds from our recent bond issue.  The new phone system will allow all of us to 
have voice mail capabilities along with many other great features. 

• New Software Installations – New software for instructors at the elementary and 
middle school computer labs have been installed.  

 
This is what we did on the summer vacation! 
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FYI: HPS now has one “specials” teacher per each elementary building. So, each building 
has its own Art, Music, PE and Technology teacher.  That means those folks do not have 
to travel between buildings anymore! ☺ 
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Lesson Plan of the Month 

The following lesson plan comes from: 

Best Practices of Technology Integration II from Michigan 
Teachers 
 



Title: Thinking Like an Engineer 
Submitted by: Kathy D. Reinhard and Lynn C. Webster 
School Building: Mancelona High School 
School District: Mancelona Public School 
School Address: 110 Carrolton St. 
                            Mancelona, MI 49659 
E-mail Address: ar103@tcnet.org 
Subject Areas: Mathematics and Physics 
Intended Grade Level(s): 9 - 12 
Description: 
The main purpose of the unit is for students to experience different ways of learning 
Physics and Mathematics in real world applications. If students construct their own 
knowledge then possibly they will remember and understand this knowledge. The major 
goal of this unit is to develop thinkers, problem solvers, and team workers through the 
use of physics and mathematics concepts. The kinds of technology used in this unit 
include, Lego Dacta kits, calculator-based laboratories (CBL), graphing calculators, and 
computers with a multi-media program like Power Point.. 
 
Narrative: 
A Chinese Proverb is in the front of all AIMS books: 
I Hear, and I Forget 
I See, and I Remember 
I Do, and I Understand 
The premise is that if students are engaged, and actively participating in their learning 
that they will remember. If students remember then they can understand and apply this 
knowledge to other real life experiences. Students may even think about a career in the 
field of engineering. This unit opens the doors for all students to learn. The standards of 
authentic instruction are met in this unit. The main approach will be through team 
learning, and cooperative learning skills (sustentative conversation and higher order 
thinking). The unit presents real life problems (connections to the world beyond the 
classroom), which students will solve in small teams. Experiencing the problem solving 
process through team learning, students will begin to distinguish, and comprehend the 
relationship between mathematics, physics, and technology (deep knowledge and higher 
order thinking). The teachers (L. Webster and K. Reinhard) involved in this integrated 
unit are modeling team learning, and cooperative learning skills. The planning and 
implementation of this unit will use those same team skills. We also feel that it is very 
important for students to see and understand the relationship between physics and 
mathematics, and that there is real life application. The assessment part of this unit will 
include journals, peer evaluation, and an interview where the team will have to present 
their machine to a panel of people with the use of technology. The physics class and the 
proficiency mathematics class, which share the same time period, will work together by 
the older students sharing the physics knowledge and the mathematics classes sharing 
their knowledge of teamwork and mathematics. Students from both classes will be 
learning/working together. 
Technology improves both student learning and understanding of mathematics and 
physics concepts. The Lego Dacta kits provide a hands-on model of simple machine 



concepts and logical reasoning/problem solving in mathematics. The CBL gathers 
physical data and the graphing calculators provide a mathematical representation of the 
relationships found in the data. Assessment of students’ understanding is a machine and a 
team presentation of the machine. The power point program gives the means to use 
technology in a sequential and creative manner. 
Thinking Like an Engineer motivates students to be better learners. We observed 
students having substantive conversations about how to solve problems or accomplish 
goals. Students were enthusiastic about learning and understanding physics/mathematics 
concepts. In the beginning of this unit we observed students being frustrated by the 
concepts and the tasks expected of them. Through the teaching methods presented, 
students became better problems solvers, acquired team skills and persevered through 
difficult assignments. The technology was a tool to assist all students to learn. The 
teamwork skills were revealed when different students (not only physics students) were 
able to contribute their knowledge of technology 
in the use of the power point program. Students’ presentations and machines were proof 
of the success of the teaching of the unit as well as the understanding and learning of the 
unit. 
Curriculum Benchmarks: 
MI.SCI.IV.3.HS.2 Describe the idea that whenever one object exerts a force on a second 
object, the second object exerts an equal and opposite force on the first object. (Key 
concepts: Action force, reaction force. Real-world contexts: Walking, swimming, 
jumping, rocket motion.). 
MI.SCI.IV.3.HS.3 Analyze the operation of machines in terms of force and motion. 
(Key concepts: Force, motion, and changes of motion— speeding up, slowing down, 
turning, push, pull, friction, gravity, attraction, repulsion, balanced, unbalanced. Real-
world contexts: Machines, such as bicycles, automobiles, electrical motors, and 
generators.) 
MI.MAT.V.2.HS.2 Represent algebraic concepts and relationships with matrices, 
spreadsheets, diagrams, graphs, tables, physical models, vectors, equations and 
inequalities; and translate among the various representations. 
Total amount of time for unit: 
Nine weeks. Lesson plans are based on a Block Schedule, where each lesson is 83 
minutes. 
Materials/Hardware/Software: 
Please refer to detailed daily lesson plan file 
Teacher preparation: 
Please refer to detailed daily lesson plan file 
Prerequisite Students Skills: 
Basic numeration skills (9th grade level) 
Teamwork skills (listener, communicator, contributor, and is respectful of other team 
members) 
Technology skills (able to use a graphing calculator, computer keyboard skills, the use of 
Power Point) 
Physical science concepts (9th grade level). 
Student Activities/Procedures: 
Please refer to detailed daily lesson plan file 



Assessment/Evaluation: 
Please refer to detailed daily lesson plan file 
Follow-up Activities: 
For extensions and follow-up activities, refer to the Aims Book, which incorporates 
extensions of specific activities used in the unit. 
 

 
 

***If you have a technology-rich lesson that you would like to share with others, 
please send it to colburnc@howellschools.com no later than the last Monday 
of the month.  
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Carole’s Training Corner  
Hello and welcome back to school! I hope you all had a wonderful summer and are once again 
eager to delve right into the New Year with renewed brio! Training did not stop this summer and I 
am happy to report that over 40 of our teachers participated in T4: Tomorrow’s 
Technology/Today’s Teachers. You can get complete class details and the September training 
calendar by visiting the training web site at http://hps.k12.mi.us/training/TrainingHomePage.htm 

One of my goals for this year is to offer at training at each building at least once a month. For the 
month of September, I will be teaching Inspiration at all of the elementary buildings and doing 
Class XP/Integrade Pro Help sessions at the high school and MMS and HWMS as well. 

Remember, if you are interested in such training, contact Kim Blair either via e-mail or at 
extension 558 to set up a time and day.  

To see the complete list of class offerings for the month, check out the calendar page at 
http://hps.k12.mi.us/training/TrainingCalendarPage.htm   

Back to top of page 
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Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ 
You can have these tips e-mailed to you directly each day by signing up at the 
above mentioned site. 

 
 
CHANGING THE SIZE OF A GRAPHIC 
Once the graphic has been placed in your document, you can resize it by 
following these steps: 
 
   1. Click on the graphic. A box appears around the element (this is 
      designated by eight squares, or handles, around the outside of 
      the graphic). 
   2. Use the mouse to point to one of the handles. Click on the left 
      mouse button. 
   3. Drag the handle to resize the graphic. 
   4. Release the mouse button when the graphic is the size you want. 
 
If you drag one of the corner handles, the proportions of the graphic 
are maintained. If you use one of the top, bottom, or side handles, 
then the proportions of the graphic are distorted. 
 
Another way to adjust the size of a graphic is to click on the picture 
once, and then choose Picture from the Format menu. This displays the 
Format Picture dialog box. In Word 6 and Word 95, you can adjust the 
scaling (size) of the picture in this dialog box. In Word 97 or Word 
2000, you must first click on the Size tab, and then you can adjust 
the scaling. When you click on OK, the new settings are applied to the 
graphic. 
 
ADDING VERTICAL LINES BETWEEN COLUMNS 
As you already know, Word allows you to add columns to your page 
layout. As part of your page layout, you may decide to add vertical 
lines between each column on your page. To do this, follow these 
steps: 

http://wordtipsgold@vitalnews.com/


 
   1. Position the insertion point at the beginning of the material 
      you want to appear in columns. 
   2. Select the Columns option from the Format menu. When you do, you 
      will see the Columns dialog box. 
   3. Specify the number of columns desired, as you normally would. 
   4. In the Apply To box, select This Point Forward. This causes Word 
      to apply columns beginning where the insertion point is located. 
   5. Click on the “Line Between” check box. 
   6. Click on OK. 
 
DISPLAYING THE RULER 
The ruler appears at the top of every Word for Windows document 
window. The ruler is used to adjust formatting and align elements of 
your page. It is very helpful if you are using Word with a mouse. 
 
Word allows you to control whether this ruler is displayed or not. To 
do this, simply select the Ruler option from the View menu. This is a 
toggle; every time you select it, the display is changed. If a check 
mark appears the left of the Ruler option, then the ruler is visible. 
If no check mark is there, then the ruler is not displayed. 
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Cool Links For You to Try… 

http://www.hps.k12.mi.us/Curriculum1.html 

http://glen.cc/mtip/ 

http://www.remc7.k12.mi.us/oaisd/miclimb/ 

http://www.cyberlearning.org/ 

http://www.brainbuzz.com/topsites/Default.asp?CatID=1 
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For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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